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Map-Based Heat Vulnerability Assessment 

1. Introduction 

In 2010/11, Toronto Public Health developed a refined heat vulnerability index and 
implemented a spatially explicit heat vulnerability assessment approach. This approach 
consists of (1) a methodology and decision support maps contained in the final project report; 
(2) the geographic information systems (GIS) project and mapping tools described in this user 
manual; and (3) a separate data maintenance and update protocol. Interaction with the GIS 
project and mapping tools provides extended functionality beyond static maps to Toronto 
Public Health. This will enable Toronto Public Health staff to produce custom maps for 
individual stakeholders to support effective hot weather preparation and response in Toronto. 
For example, high-resolution map images, custom map overlays, or detailed views of target 
neighbourhoods can be achieved. The access to the GIS project files also allows Toronto 
Public Health to export the vulnerability indices as GIS layers that can be shared with 
stakeholders, thereby addressing the expressed desire to combine the heat vulnerability 
assessment with existing data and existing tools.  

Section 2 of this user manual provides an overview of the map handling, map zooming, map 
drawing, and reporting functionality. This is followed by a sample walk-through for creating a 
heat vulnerability report for the South Parkdale neighbourhood in Toronto in Section 3. 
Furthermore, Section 4 describes the cartographic design and map layout of the pre-processed 
decision support maps, while Section 5 outlines the software development and deployment 
approach for the implementation of the mapping tools.  
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2. Overview of Functionality 

The general principle underlying the design of the mapping tools is to streamline the user 
interface for data exploration and map production by public health analysts and decision-
makers. The goal is to simplify the user’s interaction with the map and data as much as 
practical, so that users, who are experts in hot weather response but not in GIS, could easily 
access the information and use the tools. Consultation with Toronto Public Health determined 
that the appropriate software platform in terms of functionality and availability to users would 
be the ArcMap application within ArcGIS 9.3. ArcGIS is a full-featured GIS and mapping 
product, but more importantly in this context, it provides extensive possibilities for 
customizing its graphical user interface using the Visual Basic for Applications (VBA) 
scripting environment.  

 
Fig. 1: Heat Vulnerability Mapping Tool upon starting ArcMap 

ArcMap natively provides two main interface components to map users: a top panel 
containing a series of menus and toolbars above the mapping window, and a side panel 
containing the “table of contents” along the left hand side (see Fig. 1). In the Heat 
Vulnerability Mapping Tool interface, upon startup, both components are customized so that 
only the interface elements needed for heat vulnerability maps are visible. In the top panel 
there are four sections, from top to bottom:  
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1. Main menus 

2. Map Handling toolbar 

3. Map Zooming toolbar 

4. Map Drawing toolbar 

These are identified in Fig. 2. The main menus remain unchanged with their standard ArcMap 
functionality. They give the user access to most ArcMap functions via dropdown menus. The 
three additional toolbars were created for the Heat Vulnerability Mapping Tool. Subsequent 
sections provide details about each toolbar’s functionality.  

 

 
Fig. 2: Detail of standard main menus and custom toolbars added to Mapping Tool interface 

Additional ArcMap user interface components are not visible on startup, but may be added to 
the interface if required. For example, ArcMap does provide a large number of toolbars for 
additional functionality. These may be added using the View->Toolbars menu function. 
ArcMap toolbars that experienced GIS users may find useful include:  

x Standard, for handling map documents (open, save, etc.) 

x Tools, for map navigation and querying (zoom, identify, etc.) 

x Layout, for navigation in map layout view 

x Draw, for editing the map layout 

Similarly for the side panel “table of contents”, full functionality is available for experienced 
GIS users who wish to turn map layers on or off, and access the data behind them. However 
this is not necessary for users who only wish to use the basic visualization and reporting tools 
provided in the Heat Vulnerability Mapping Tool.  

Conversely, to remove any or all of the customized toolbars, the user can navigate to the 
View->Toolbars menu function, find the custom toolbars with labels starting with “TPH”, and 
uncheck them.  
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2.1 Map Handling Toolbar 

 
This toolbar includes buttons to open, save, print, and export the decision support maps from 
the map series included with the final project report. It also includes a button to generate a 
report on a selected neighbourhood.  

 

2.1.1 Opening a Map 

Clicking the “Open...” button takes you to the MapProjectFiles directory (Fig. 3). You can 
then navigate to the subdirectory and specific heat vulnerability map file, which you wish to 
open. Map documents are stored with the ArcMap file extension *.mxd.  

 

 
Fig. 3: Open map function 
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2.1.2 Saving the Map as a New Document 

Clicking the “Save as...” button takes you to the directory, in which you most recently saved a 
file. It is recommended that map files made for specific purposes be saved within a local or 
personal directory, such as My Documents\My HVA Maps.  

 

 
Fig. 4: Save as function 
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2.1.3 Printing the Map 

Clicking the “Print...” button brings up ArcMap’s standard print function, which prints the 
current map layout view. The “Print” and “Print and Page Setup” window will vary according 
to your available printers, but the latter should look similar to Fig. 5. You may have to click 
the radio button “Scale Map to Fit Printer Paper”. The printer page must be set up as Letter 
and Landscape; if it is not, you may have to click on the printer “Properties” button below to 
access the “Print and Page Setup” window to set these.  

 

 
Fig. 5: Print function (ArcMap standard) 
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2.1.4 Exporting the Map as an Image or PDF file 

Clicking the “Export Map...” button brings up ArcMap’s standard Export Map function, which 
will generate a “snapshot” of the current ArcMap page layout. You will be able to choose 
which file format to generate (see Fig. 6). Use this function to export an image file to be used 
as an illustration within a document or slideshow (e.g. Word or Powerpoint). Recommended 
image file formats include the compressed formats PNG, GIF, or JPG, or the uncompressed 
TIFF format. This function may also be used to export the map layout to a Portable Document 
Format (PDF) file, which can be distributed by email or printed as a handout.  

 

 
Fig. 6: Export Map function 
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2.1.5 Generating a Report 

The “Generate Report” button will create a report summarizing the area and data that have 
been selected. This report is generated in a Web page format suitable for printing and 
archiving. It is designed to be used in conjunction with the “Zoom to” functions to focus on a 
specific area such as a City neighbourhood, ward, priority area, or postcode region, and 
summarize the data on vulnerable populations within the Census tracts of that area. The 
resulting one-page report includes the map and a summary table. The table sums the count 
values for eleven variables for the general population and seven variables for seniors within 
the selected Census tracts.  

Upon clicking the button, you will be presented with three message prompts requiring a 
response before the page will be generated:  

Prompt Default 

1. Map Export Path? c:\temp\ArcMapExport.jpg 

2. Report Export Path? c:\temp\ArcMapSelectionReport.html 

3. Report Title? TPH - Heat Vulnerability - Neighbourhood Report - [date] 

In all cases a default is provided so that you can just click “OK”. Or, you can change these 
settings to save and name the files as you wish. After collecting your responses, Internet 
Explorer will open with the report in Web page format. An example of a report is provided in 
Section 3. After the report is generated and displayed, you can use the Internet Explorer menu 
(File->Save as...) to save the Web page file to your personal directory.  

Reference tables with City-wide totals as well as average and median counts per 
neighbourhood, ward, priority area, and postcode regions are provided in Appendix A.  

 

Troubleshooting “Generate Report”:  
As mentioned, the tool is designed mainly for generating reports after the “Zoom to” function 
is run, which also selects the Census tracts in the target area. If that has not been done, you 
may get the message “There were no selected features found in the report”. The report will be 
created, but with no data filled into the table.  

There is an unusual circumstance which could interrupt this smooth process. This issue occurs 
when the correct data layer for generating the report is not highlighted. The total count data for 
the table come from the map layer “tor_2010_coverage”. This layer must be highlighted in the 
table of contents panel on the left side of the map (see Fig. 7a). This is the default upon start-
up, but if you have clicked on another layer you may have highlighted it accidentally. In this 
case upon clicking “Generate Report” an error message will come up (“Error: Object variable 
or With block variable not set”). To fix this, click on the tor_2010_coverage layer once to 
highlight it as shown in Fig. 7, and then click “Generate Report” again.  
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Fig. 7a: Highlighted layer for “Generate Report” 

An additional issue may arise when the Heat Vulnerability Mapping Tool is used on a 
computer that has a different Microsoft Windows setup than the development computer. 
Because the generate report function creates a file, it needs access to the Windows operating 
system. For this, the tool’s program code needs to reference the “Microsoft Scripting 
Runtime” library.  

If clicking the “Generate Report” button results in an error message that refers to an 
“automation” or “reference” problem, or a “library not found” error, then this library may not 
be correctly installed. To remedy the situation, select Tools-Macros-Visual Basic Editor, or hit 
ALT+F11 in ArcMap, to open the Microsoft Visual Basic window. From this window’s menu 
bar, select Tools-References... to open the list of program libraries used. If “Microsoft 
Scripting Runtime” is unchecked, click its checkbox. If it is entirely missing from the list, use 
the Browse... button to find the file “scrrun.dll” in the folder C:\Windows\system32, which 
will add this library to the list. In both cases, close the Visual Basic window and use File-Save 
in ArcMap’s main window to store the modified map project file.  

Alternatively, if the reference to “Microsoft Scripting Runtime” appears to be correct 
(checked, not marked as “missing”), then uncheck it, close the Visual Basic window, save the 
map file, and close ArcMap. Then, re-open ArcMap with the same map and follow the steps 
above to find and check the “Microsoft Scripting Runtime” library. A screenshot of the 
references list with the Scripting library activated is shown below.  

 
Fig. 7b: Visual Basic references list with with the Scripting library activated 
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2.2 Map Zooming Toolbar 

 

 
This toolbar contains a button and three dropdown menus to zoom to detailed map views, and 
to reset the map layout.  

 

2.2.1 Zooming to the Whole Page 

Clicking this button runs the standard ArcMap function “Zoom Whole Page”, which reverts 
the map layout view to showing the page layout fitted to the current window size. This 
function may be needed after repeatedly zooming to different city neighbourhoods or other 
areas, which affects the page layout.  

Tip:  
If the map on your screen slipped out of place, try using the “Zoom Whole Page” button to 
reset the map page back to a centred, fitted position.  

 

2.2.2 Zooming to City Neighbourhood, Ward, or Priority Area 

The “Zoom to” tools assist with focusing on a area. There are three sets of areas, as defined by 
the City of Toronto: neighbourhoods, wards and priority investment areas. Use these drop-
down “combination box” tools to select one of these areas by name. Doing so will zoom the 
map extent to the area and select the Census tracts within it. It will also highlight its extent by 
masking the surrounding Census tracts (see illustration in Section 3). At this point, you can 
use the “Generate Report” tool as outlined above. If you wish to see the zoomed area without 
masking out the surrounding Census tracts, use the “Zoom mask OFF” tool on the Map 
Drawing Toolbar as explained below.  

 

2.2.3 Zooming to Ipsos-Reid Postal Code Region 

 
The Ipsos-Reid Postal code regions are aggregations of Canada Post forward-sortation areas 
(three-digit postal code areas) used for reporting survey data. An additional “Zoom to” 
combination box tool was created for these areas. Since these regions are less commonly used 
than the city-defined areas listed above, this toolbar is not included in the start-up default 
interface for the Mapping Tool. It can be added below the other toolbars by using the main 
menu function “View->Toolbars->TPH – IPSOS REID zoomto”. This dropdown works just 
like the other “Zoom to” tools.  
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2.3 Map Drawing Toolbar 

 
This toolbar combines buttons that modify the data layers shown in the map, or how they are 
shown.  

 

2.3.1 Showing an Additional Layer with Adaptation or Context Information 

The “SHOW a Context Layer” tool has been designed to add a single adaptation or context 
layer as an overlay onto the current map. On startup, these layers are hidden in the table of 
contents to encourage their access through this tool, as can be seen in Fig. 8. Clicking on the 
black triangle on the right of the tool name triggers a drop-down menu of the 12 available 
adaptation and context layers. Clicking on one of these turns it on, and simultaneously turns 
off any other context overlay.  

 

 
Fig. 8: Adaptation/Context overlay tool 

 

For those users who are familiar with GIS and wish to use the full ArcMap interface, the full 
set of adaptation and context layers can be opened in the table of contents and its checkboxes 
and other tools used.  

 

2.3.2 Showing/Hiding Vulnerability of Surrounding Neighbourhoods 

As described above, when one of the “Zoom to” tools is invoked, it highlights the selected 
area by masking the surrounding area. To remove this mask, in order to see the surrounding 
Census tracts symbolized for exposure, sensitivity, or vulnerability (depending on the map at 
hand), click the “Zoom Mask OFF” button. This tool will reveal the shades of red in the 
surrounding area. To revert to the masked view of the map, use the “Zoom to” tool again.  
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2.3.3 Resetting the Map 

Click on the “RESET Map” button to zoom out to the full extent of the City of Toronto, and 
turn off any of the context and adaptation layers that may have been turned on. This 
effectively returns the map to its default startup state.  

Tip:  
If the map on your screen appears to be “mixed up”, try using the “RESET Map” button to 
reset the map extent and map layers to their original status.  
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3. Sample Usage – Heat Vulnerability Report for South Parkdale 
Neighbourhood 

In this section, a series of steps have been assembled as an example of using the customized 
user interface, to serve as an introduction to the Heat Vulnerability Mapping Tools. We will 
generate a heat vulnerability report for the South Parkdale neighbourhood.  

 

3.1 Opening the Heat Vulnerability Mapping Tools 

Navigate to the startup directory for the Heat Vulnerability Maps. This will normally be 
something like ../username/TPH 2011/HVA_Deliverables/MapProjectFiles. Within this 
directory, select and open the HVA Startup mapfile:  

 HVA Startup Map 4.4 Vulnerability to Heat.mxd.  

 

3.2 Opening an Existing Decision Support Map 

On the Map Handling Toolbar, click the  button, and using the standard ArcMap 
“Open” window, navigate to the specific map you wish to view. All of the Exposure, 
Sensitivity, Index, and Coverage maps developed for this project have the customized Heat 
Vulnerability Mapping Tools incorporated into them. As an example, navigate to the 
following map document and open it: 

..\MapProjectFiles\SensitivityMaps_GenPop\Map 2.1.1 Low-Income Persons.mxd 

 

3.3 Zooming to an Area of Interest –  The South Parkdale Neighbourhood 

If your map page looks small, click on the  button. Then use the “ZOOM to 
Neighbourhood” combination box dropdown to select “South Parkdale”. The selection process 
and the resulting map should look like Fig. 9 below. The map is zoomed to the area of South 
Parkdale, the map title now reflects this, the neighbourhoods around it are labelled, and the 
surrounding area is masked to highlight the area of interest. If you want to see what the 
percentages of the population with low incomes are in the surrounding census tracts, you can 

click the  button to reveal them. You can try this now, and then refresh the 
highlighted view by zooming to South Parkdale again.  
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Fig. 9: Zoom to South Parkdale neighbourhood 

 

3.4 Generating a Report on the Census Tracts in South Parkdale 

Click on the  button to create the summary report containing the map and table 
for South Parkdale. You will be requested to supply the “Map Export Path”, “Report Export 
Path”, and “Report Title”. For now, leave the default for the first two requests, but change the 
title to something like “TPH South Parkdale Summary Report” – with the automated date and 
time left as they appear, and click OK. An Internet Explorer browser window will then open 
containing the summary report, which should appear much like Figure 10, below.  

The report reproduces the map page layout as it appears in ArcMap, reports that there are four 
Census tracts included in the South Parkdale neighbourhood, and the table provides count data 
totalled up for those four Census tracts for each of the 18 reporting variables. To compare the 
tabulated data with City-wide totals and neighbourhood averages and medians, refer to the 
neighbourhood reference table in Appendix A.  
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Fig. 10: South Parkdale summary report 

 

3.5 Saving the Generated Report 

If you wish to save the report for future usage, use the Internet Explorer menu “File->Save as” 
to save it in your own directory under a new name, such as:  

../username/My Documents/Report-SouthParkdale.mht 

It is recommended to save it as a Web archive single file (*.mht file), but it may also be saved 
as a complete Web page (.htm file with named directory attached), but not as a Web page 
(HTML only.) This will ensure that the map image is saved along with the report. These files 
may then be opened in the browser of your choice (Firefox, Chrome, etc.), while the automatic 
opening of the report upon generating is currently limited to Internet Explorer. Various 
utilities are available to convert the Web page into more portable file formats such as PDF for 
printing or digital sharing.  
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4. Cartographic Design and Map Layout 

This section describes the project’s cartographic design principles and the map layout, in 
which the decision support maps are provided. This information is reported for those users 
who may wish to modify the existing maps.  

4.1 Map Template and General Mapping Principles 

Fig. 11 shows the ArcMap template used for thematic mapping of exposure and sensitivity 
indicators as well as composite heat vulnerability indices. The Universal Transverse Mercator 
(UTM) Zone 17N projection was applied to all maps in this report. Note that the orientation of 
the map has been rotated by -16° according to City of Toronto mapping guidelines.  

 
Fig. 11: Template for decision support maps 

Highways and selected major streets are provided for orientation. Stakeholders suggested 
displaying more street names, linking the maps to postal codes, and adding railroad lines for 
orientation. However, this information would affect the legibility of the thematic symbols and 
therefore should not be included at this time. In an interactive desktop or online tool, the 
suggested layers could be included and the decision to display them left with the end-user. A 
layer with non-residential areas was used when mapping population, dwellings, and some 
exposure variables. Areas with “no data” are displayed with a distinctive line hatch pattern.  

It is important to note that the legends for all decision support maps were customized. 
Therefore, the legends are not connected to the map layers. If a layer’s symbology or 
underlying data change, new legend items for this layer need to be created and arranged 
manually.  
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The thematic maps were numbered according to the components of the conceptual framework 
for the heat vulnerability assessment:  

1. Maps of exposure indicators 
2. Maps of sensitivity indicators 

2.1. General population sensitivity 
2.2. Seniors sensitivity 

3. Adaptation and context maps (transparencies/overlays) 
4. Maps of potential vulnerability (composite indices) 
5. Coverage maps (count symbol overlays) 

5.1. Overlay of exposure counts 
5.2. Overlay of general population sensitivity counts 
5.3. Overlay of seniors’ sensitivity counts 

 

4.2 Thematic Colour Scheme and Classification Method 

The decision support maps were designed as choropleth maps, where shades of colour fill the 
polygons representing enumeration units, i.e. Census tracts. Lightness is the primary visual 
variable that determines the effectiveness of a choropleth map. The logical progression of 
values along the number line should be matched with a progression of lightness levels. A 
sequential colour scheme with a logical progression from light to dark in a given colour hue 
(e.g. red) also enables greyscale printing and photocopying of colour maps, as requested by 
hot weather response plan stakeholders. Subordinate changes in colour hue and saturation can 
further support a map’s effectiveness.  

Following the above guidelines, the advice from some stakeholders to use a diverging colour 
scheme with two hues, e.g. blue and red, could not be heeded. Similarly light or dark shades of 
the two hues could not be distinguished in greyscale print, requiring separate map series to be 
produced for greyscale printing. In addition, neighbourhoods shown in blue or green for lower 
temperatures and lower vulnerability levels could be misinterpreted as being cool or not 
vulnerable at all, due to typical associations with these colours.  

To avoid stigmatization of high-risk neighbourhoods, Toronto Public Health requested the 
consideration of colour hues other than red for the most vulnerable areas. An online tool, 
ColorBrewer (http://www.colorbrewer2.org) that guides map authors in selecting appropriate 
colour schemes for thematic mapping, was used to determine suitable colour schemes. The 
tool considers the number of data classes, the nature of the data being mapped (qualitative vs. 
quantitative; bi-polar), and the intended display environment for the map (i.e. print, 
photocopy, projection) in recommending suitable colour schemes. ColorBrewer also provides 
the numerical specifications for the selected scheme in RGB, CMYK, and HEX for users to 
import into commercial GIS software.  

Generally, red or orange were identified as the best colours to map exposure, sensitivity and 
potential vulnerability due to their association with heat. Blue and green tones were dismissed 
because of their association with coolness, and the need to use the darker, more intense end of 
the colour scheme for the areas of greater interest, i.e. the most vulnerable areas. A blue-
purple and a purple-red colour scheme from ColorBrewer were explored, but found to be not 
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photocopy friendly. Three red or orange colour schemes were tested in more detail to 
determine the best scheme for the decision support maps.  

 
Fig. 12: Five-class sequential red-orange colour scheme from ColorBrewer 

 
Fig. 13: Six-class sequential red-orange colour scheme from ColorBrewer without the darkest class 
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Fig. 14: Five-class sequential red-pink colour scheme from ArcMap 9.3 

 

The selection of a colour scheme was ultimately based on visual separability between data 
classes and the ability to easily distinguish map overlays. The five-class sequential red-pink 
colour scheme from ArcMap 9.3 (Fig. 14) was selected because it produced the best results on 
a computer monitor and in print. In the five-class sequential red-orange colour scheme from 
ColorBrewer (Fig. 12), the lightest colour was too similar to the white depicting non-
residential areas. In the six-class sequential red-orange scheme from ColorBrewer, from which 
the five lightest classes were considered (Fig. 13), the second and third lightest colours were 
difficult to distinguish on a computer monitor and in print. Another experiment was made by 
using a green colour scheme for variables related to green space (while keeping the red-pink 
scheme for all other variables). However, for consistency among the maps, it was decided to 
use the red colour scheme on all maps, and to always use dark red for high-risk values in any 
variable.  

Indicators and indices were classified for mapping using the quintiles classification method, 
which separates the data values into five classes of the same number of objects (Census tracts). 
Some stakeholders suggested simplifying the information on the vulnerability maps by 
including only three classes, and assigning actions (recommended interventions) to each of 
them. Cartographically, a number of 5-7 classes is generally recommended. It would also be 
difficult to assign a specific action to each class because the same maps may be used by 
stakeholders with very different mandates and resources, e.g. a community health centre on 
the one hand, and Toronto Public Health on the other. However, Toronto Public Health could 
develop guidelines on how to use the maps to support hot weather response.  

For the coverage maps, counts of at-risk population groups were mapped using proportional 
symbols. The Census tracts with the highest counts were mapped in order to identify large 
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counts of at-risk groups that fall inside or outside of high-vulnerability census tracts. The cut-
off point for mapping counts was set at 50% of the total count of the at-risk population (when 
the total count mapped equalled 50% of the total count, no further Census tract counts were 
mapped). In this way only the census tracts with the largest number of the at-risk groups are 
included. This approach shows if large numbers of particular at-risk groups fall outside of the 
identified high-vulnerability census tracts so that strategies targeted to this group can also 
include these areas. Raw-count variables must never be mapped using choropleths, but 
proportional symbols are an appropriate representation technique that is independent of the 
size of enumeration units. Circles were chosen as the symbols, since they are neutral and 
generally fit well into corresponding polygon areas (Census tracts). Hollow circles are 
recommended because they keep the underlying vulnerability index legible. The circles were 
classified into quintiles and overlaid on top of the choropleth map layer with the potential 
vulnerability index values. Ranges of circle sizes were described in the map legend. 
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5. Implementation of the Decision Support Functionality 

The Heat Vulnerability Mapping Tool is implemented in Visual Basic for Applications 
(VBA). The VBA program code is included in each of the decision support maps (*.mxd 
files). The implementation also required the addition of the zoom neighbourhood boundaries 
and the adaptation and context overlay datasets in each map document.  

Tip:  
The decision support maps should be installed in a read-only directory, so that upon closing, 
they will revert to the startup settings. If you wish to save a revised map, for example, zoomed 
to a certain area, you should do so in a personal directory. In this way, the Heat Vulnerability 
Mapping Tool is maintained in its original working state for your future usage, or for other 
users.  
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6. Appendix A – Reference Tables 

Variable City Neighbourhoods 
Description Total Average Median 
Units in buildings with 5+ storeys 377475 2696 1915
Rented units in buildings with 5+ storeys constructed before 1986 218760 1563 1093
Low income persons (2005, after tax LICO) 475563 3397 2664
Children age 0-5 in low-income families 50530 361 226
Renter households spending >= 50% of income on housing 100545 718 628
Low-income renters spending >= 50% of income on housing 100665 719 608
Persons not speaking English  132105 944 650
Persons immigrated 2001-2006 266810 1906 1533
Adults without high school certificate 310795 2220 1848
Persons in racialized groups 1158545 8275 5760
Persons age 25-64 with a disability 230500 1646 1400
Low income and living alone among seniors (age 65+) 39220 280 248
Low income among seniors (age 65+) 40599 290 244
Senior families spending >= 30% on housing 27095 194 165
Unattached seniors spending >= 30% on housing 50265 359 300
Seniors not speaking English 53470 382 240
Unattached seniors with a disability 54695 391 343
Seniors age 65-74 with a disability 74135 530 470

 
Variable City Wards 
Description Total Average Median 
Units in buildings with 5+ storeys 377475 8206 7705
Rented units in buildings with 5+ storeys constructed before 1986 218760 4756 4443
Low income persons (2005, after tax LICO) 475563 10338 11343
Children age 0-5 in low-income families 50530 1098 988
Renter households spending >= 50% of income on housing 100545 2186 1960
Low-income renters spending >= 50% of income on housing 100665 2188 1930
Persons not speaking English  132105 2872 2575
Persons immigrated 2001-2006 266810 5800 5110
Adults without high school certificate 310795 6756 6613
Persons in racialized groups 1158545 25186 23258
Persons age 25-64 with a disability 230500 5011 5115
Low income and living alone among seniors (age 65+) 39220 853 838
Low income among seniors (age 65+) 40599 883 844
Senior families spending >= 30% on housing 27095 589 545
Unattached seniors spending >= 30% on housing 50265 1093 1065
Seniors not speaking English 53470 1162 968
Unattached seniors with a disability 54695 1189 1198
Seniors age 65-74 with a disability 74135 1612 1693
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Map-Based Heat Vulnerability Assessment 

 
Variable City Postcode Regions 
Description Total Average Median 
Units in buildings with 5+ storeys 377475 26963 25168
Rented units in buildings with 5+ storeys constructed before 1986 218760 15626 13530
Low income persons (2005, after tax LICO) 475563 33969 29787
Children age 0-5 in low-income families 50530 3609 3498
Renter households spending >= 50% of income on housing 100545 7182 5840
Low-income renters spending >= 50% of income on housing 100665 7190 6103
Persons not speaking English  132105 9436 9048
Persons immigrated 2001-2006 266810 19058 16198
Adults without high school certificate 310795 22200 20300
Persons in racialized groups 1158545 82753 75515
Persons age 25-64 with a disability 230500 16464 14153
Low income and living alone among seniors (age 65+) 39220 2801 2628
Low income among seniors (age 65+) 40599 2900 2669
Senior families spending >= 30% on housing 27095 1935 1635
Unattached seniors spending >= 30% on housing 50265 3590 3588
Seniors not speaking English 53470 3819 3638
Unattached seniors with a disability 54695 3907 3803
Seniors age 65-74 with a disability 74135 5295 5280

 
Variable Priority Areas 
Description Total Average Median 
Units in buildings with 5+ storeys 79745 6134 5660
Rented units in buildings with 5+ storeys constructed before 1986 47335 3641 3265
Low income persons (2005, after tax LICO) 115570 8890 7490
Children age 0-5 in low-income families 16230 1248 1280
Renter households spending >= 50% of income on housing 17075 1313 1310
Low-income renters spending >= 50% of income on housing 17470 1344 1250
Persons not speaking English  33825 2602 1705
Persons immigrated 2001-2006 69590 5353 4580
Adults without high school certificate 74425 5725 4905
Persons in racialized groups 319995 24615 18580
Persons age 25-64 with a disability 47210 3632 2890
Low income and living alone among seniors (age 65+) 8055 620 580
Low income among seniors (age 65+) 8988 691 637
Senior families spending >= 30% on housing 6185 476 450
Unattached seniors spending >= 30% on housing 9390 722 640
Seniors not speaking English 13010 1001 685
Unattached seniors with a disability 9465 728 730
Seniors age 65-74 with a disability 15700 1208 1070
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